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The Diamondback, the University of Maryland’s independent student-run newspaper is published by Maryland Media Inc. – a 501c3 nonprofit.

Published continuously since 1910, The Diamondback is College Park’s only newspaper and #1 source for news, sports, and entertainment and is published 
continuously online daily at DBKnews.com. The Diamondback reaches 100,000 readers each week and is regularly recognized for editorial excellence, 
including being named the #1 college newspaper in the country four times by the Society of Professional Journalists.

Address
Published by Maryland Media Inc.
3136 South Campus Dining Hall
College Park, MD 20742
301.314.8000

Staff
Editor-in-chief: Daisy Grant
Business Manager: Craig Mummey 
General Manager: Arnie Applebaum

Advertising Director: Ayla Kinnaird 
Advertising Manager: Sophia Alexander 
Advertising Manager: Bridget Brown 
Advertising Manager: Ethan Tuttle

Advertising email: dbkadvertising@gmail.com

WHY ADVERTISE?

Website Conversions
Advertise on 
dbknews.com to see 
more traffic driven to 
your website.

Increase Sales
Adding coupons 
& special deals 
brings customers 
to your business.

Brand Recognition 
Make your
business known
to UMD students.
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Where Do College Students Spend Their Money?

Average Grocery Store  
purchases per month

Average Restaurant
purchases per month

Average Bar
purchases per month

Average Drug Store 
purchases per month

Students taking winter
or summer classes

Students who plan to 
attend a grad program

5.9 5.7 4.1 3.4 65% 85.2%

Statistics

Source: MMG Advertising, March 2018

91+9
The number of students, 
faculty & staff who read 

The Diamondback at least 
once a week

91% 36+64
University of Maryland students 

who are from Out-of-State

36%56+44
University of MD

students with a paid job

56%66+34
Amount of student 

income used for dining, 
drinks & snacks

72%

The amount spent each year by
College Park’s students, faculty & staff

The Average Age of all the
University of Maryland students

The total number of students
at the University of Maryland

$650 Million 21 47,964

AUDIENCE
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Welcome Back
Basketball Preview
Terp Housing
Coloring Book
Looking Back
Orientation Guide

August 24, 2020
November 2, 2020
November 30, 2020
December 7, 2020
April 26, 2021
May 21, 2021

March Madness
Salary Guide
Orientation Guide
Welcome Back

March 15, 2021
April 26, 2021
May 14, 2021
August 30, 2021

Product Publication Date Product Publication Date
PRINT ONLINE

Basketball Spirit Papers
Spirit Papers are placed on EVERY STUDENT SEAT at the top 
basketball games each season!

Terp Housing Guide
Distributed on campus including dormitories. With only freshmen 
and sophomores living on campus, this audience needs to find 
somewhere off campus to live by their junior years.

Looking Back
The Diamondback Congratulates the Class of 2021. Distributed 
throughout campus with supplemental distribution at the main 
commencement ceremony. Ideal for graduate schools, employers 
and local businesses trying to reach this valuable audience. 

Salary Guide
We’ve pledged to hold the University of Maryland accountable in 
our coverage. Our annual salary guide lays out each university 
employee’s yearly pay in an easily digestible format. Don’t miss 
this chance to be included in our MOST sought after publication 
of the year!

Orientation Guide
Pay once to be in every single incoming freshmen and their parents’ 
hands at all summer orientation sessions. Gain loyal customers 
the very first time they are on campus after their acceptance. 

Welcome Back
The Diamondback’s Survival Guide will be the student’s keepsake 
resource for surviving the academic year. Students receive their 
guide during move-in and will refer back to it throughout the 
year, from tips for finding late-night meals to figuring out the best 
way to travel to D.C.

SCHEDULE
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Get your message directly into the hands of all incoming students AND their parents! Your ad in the Orientation Guide will be distributed to all summer 
orientation visitors — 15,000 copies all for one LOW cost! Distribution directly to all new students and their parents at every summer orientation session.

The DBK Orientation Guide will also be available at the highest traffic locations and buildings all summer long – including the Stamp Student Union, the 
libraries and orientation dorms. Everyone knows that first impressions are the most important. The Orientation Guide enables you to reach all these new 
customers and their parents at precisely the right moment — when they are learning and absorbing information about UMD and College Park. 

Every page and every ad is in color for no additional cost. Pulishes: May 21, 2021 • Ad Deadline: April 30, 2021.

Premium  
Back Cover 9.44”x10” $2800
Inside Front Cover 9.44”x10” $2700
Page 3 9.44”x10” $2700
Center Spread 19.88x10” $4300
Pop-Up Ad 19.88”x1.375” $3000
Post-It Note on Cover*  3”x3”** $3000
*Includes Full Page Ad   **trimmed to 2.875”x2.875”
Standard
Full Page Ads 9.44”x10” $2100
Half Page Ads 4.65”x10” $1300
Half Page Ads 9.44”x5” $1300
Quarter Page Ads  4.65”x5” $800

Full Page 9.44”wide x 10”tall
Half Page Horizontal 9.44” wide x 5”tall
Half Page Vertical 4.65”wide x 5”tall
Post-It Notes 3” wide x 3”tall (trimmed to 2.875” x 2.875”)
Coupons 1.788”wide x 2”tall

Pre-Printed Inserts  $3000
Pre-Printed Inserts in conjunction $1800
with any Full Page Ad  

Ask your sales rep for information about price reductions for self-printing.

Publication Date May 21, 2021
Space Reservations April 30, 2021
Art April 30, 2021
Camera-Ready Art May 7, 2021

POSITIONS AD SPECS

INSERTS

DEADLINES

(prices include printing on 60lb gloss)

1. You can see the Wash-

ington Monument from 

the top of Maryland Sta-

dium.

2. UMD has seven — count 

‘em, seven — libraries.

3. More than 100 cou-

ples get married on the 

campus every year, in the 

chapel.

4. There’s a spot on campus 

that is supposedly cursed 

— if you step on the Point 

of Failure, you won’t 

graduate in four years.

5. UMD researchers made 

a computer that can 

beat Jeopardy! winner 

Ken Jennings.

6. There are actually six 

different Testudo stat-

ues at different places 

around campus.

7. Once upon a time, 

Maryland fans were vot-

ed as one of the worst 

fan bases in the U.S. — 

due to riots in the streets 

of College Park.

8. People leave offerings 

to the Testudo statue in 

front of McKeldin Li-

brary. One time, things 

got out of hand and Te-

studo caught on fire.

9. Some of National 

Treasure 2 was shot in 

front of the former Hol-

zapfel Hall on McKeldin 

Mall. Part of St. Elmo’s 

Fire was shot on Frater-

nity Row.

10. Part of the music 

video for Hootie and the 

Blowfish’s song “Only 

Wanna Be With You” 

was shot at Reckord Ar-

mory.

11. UMD has its own golf 

course.

12. UMD also has its own 

farm, at which there is a 

(living) cow with a hole 

in it.

13. Queen Elizabeth II 

of England attended her 

first American football 

game at UMD.

14. McKeldin Mall is the 

longest collegiate mall 

in the country (no mat-

ter what the University 

of Virginia says).

15. The Testudo statues 

on the campus are based 

on an actual Diamond-

back Terrapin, whose 

taxidermied body is in 

the University Archives.

16. The Maryland men’s 

basketball team won the 

2002 National Champi-

onship, and the women’s 

basketball team won the 

national title in 2006.

17. Morrill Hall is the only 

campus building that sur-

vived the 1912 Great Fire.

fun facts ab
out umd

As the flagship university of the state of Maryland, UMD has a lot of history, and also 

a lot of fun facts. Brush up on your trivia before the semester starts!
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TERPS’ APARTMENT GUIDE

You’re probably living in a dorm this year, but eventually you’ll spread your wings and leave the nest. 

When you move to an apartment or house, these are some of the locations you’ll have to choose from.

South Campus Commons

Starting at $900/month

Located on campus, south of 

the mall, these are public-private 

housing, meaning you pay rent but 

still live on the campus in these 

apartments. They can house 1-4 

people, with single bedrooms. 

Utilities are included.

The Courtyards

Starting at $700/installment

S i m i l a r  t o  S o u t h  C a m p u s 

Commons, except  that  these 

apartments are located off Metze-

rott Road and they have a pool. 

They can house 2 or 4 people. 

Utilities are included.

University View 

Starting at $939/month

These two apartment towers are 

located off Route 1, on the right 

side of campus. They’re right 

near McDonald’s, a 7-Eleven and 

other restaurants and have a pool, 

workout room and other ameni-

ties. The units house 1-4 people. 

You will have to pay extra for utilities.

The Varsity 

Starting at $949/month

Basically the View 2.0 — same 

look, same amenities, similar 

pricing.

The Domain 

Starting at $1,656/month 

These are apartment build-

ings located near the architec-

ture school and the Art-Sociol-

ogy Building, near the west side 

of campus away from Route 1. 

They have a fitness center, and 

washers and dryers are included 

in each unit. They can house 2 or 

4 people. You’ll have to pay extra 

for utilities.

Old Town 

Prices vary

This is a neighborhood on the 

other side of Route 1 from campus. 

Houses are available here for larger 

groups. You will have to pay extra 

for utilities.

The Landmark 

Contact leasing offices for 

prices

These are on the opposite side of 

Route 1 from campus. They house 

1-4 people in multiple types of 

floor plans. Amenities include a 

fitness center, inner courtyards 

and living above Target Express.

Terrapin Row 

Apply for prices

These apartments are just south 

of campus on Knox Road. Ameni-

ties include a pool, a fitness center 

and outer courtyards. Houses 1-4.

Metzerott Road 

Prices vary

A variety of houses are available 

for rent in this residential area, 

just north of Xfinity Center and in 

between Routes 1 and 193. You can 

drive there from either side, but 

to get out you’ll have to take 193.

Mazza Grandmarc 

Starting at $880/month

This complex is located further 

north on Route 1 toward Beltsville. 

Typically, graduate students live 

here. Tanning beds, a  fitness 

center and an outdoor grilling 

area are included amenities, and 

it houses 1-4.

The Enclave 

Starting at $750/month

This is on Route 1 just south of 

Metzerott Road. It houses 2-4 and 

includes a fitness center, a tanning 

room and a courtyard.

Monument Village 

Starting at $1,650/month

On Route 1 north of 193, this 

complex offers balconies and 

patios, stackable washers and 

dryers, a pool, a fitness room, a 

zen garden, a pet spa and way too 

many other things for us to list. (In 

other words, you get what you pay 

for.) It houses 1 or 2.
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what’s r
ed, white, a

nd gold all
 over? t

ailgates...

A
t every home football 

game, the campus is 

covered with fans of 

all ages. You’ll want to take 

part in the revelry at a tail-

gate, and there are plenty of 

options to choose from:

IFC tailgate

Over the past couple of 

years, the Interfraternity 

Council tailgate has been at 

the football practice fields. 

It’s limited to people with 

wristbands, which there are 

usually several thousand of. If 

you’re able to get your wrists 

on one, there’s tons of food, 

drinks and games in store.

Terp Up for Game Day 

Two hours before each 

home game, La Plata Beach 

turns into a huge tailgate 

zone, open to everyone. 

With tunes from HOT 99.5 

blasting on the speakers, you 

can get face and body paint, 

make signs and get revved up 

for kickoff. 

Hosting your own

Parking on campus isn’t 

cheap (see page 10 for more 

on that), but if you’re able 

to swing a spot on Saturday, 

you might as well bring a grill 

and some burgers. Check out 

the tailgate rules so you don’t 

get in trouble — you won’t 

be able to watch the game if 

you’re booted from campus.

At any Maryland sports game, whether it’s against a hated Big Ten rival or an uninspiring mid-major foe, you’ll be among a bois-

terous crowd that isn’t afraid to get in on the action. From chants and songs to creative signs to coordinated antics, everything goes 

when the Terps are playing. It’s deafening, it’s vulgar and it’s among the best things you’ll experience here.

F
or several years, one Maryland 

men’s basketball game each 

season has featured a flash 

mob. You’ve seen the videos: The 

entire arena is in sync, wearing the 

same thing and moving the same way 

as the music pounds. 

Get to the game a few hours before-

hand — this much choreography takes 

a lot of practice — and you can join the 

fun. But remember your cues: You 

don’t want to be the one person whip-

ping when everyone else is nae-naeing.

I
f you start to hear the theme 

from 2001: A Space Odyssey, 

you’re about to take part in 

maybe the best tradition Mary-

land has to offer. During home 

games for football and men’s 

basketball, a massive Maryland 

flag is unfurled across the student 

section. 

When it comes to you, do your 

part for Maryland pride and hold 

it up. (And don’t worry — it won’t 

be there too long.)

flash 

mobs...
...and 
the flag

21
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2018 

septem
ber

october

november

december

2019

march

april

may

2018-19 calendar

9/12 - 9/13: First Look Fair

9/15, 9/22: Football Home Games

10/7 - 10/14: Homecoming Week

10/13: Football Homecoming Game 

10/27: Football Home Game

11/3, 11/17: Football Home Games

11/21 - 11/25: Thanksgiving Break

12/12 - 12/18: Final Exams

3/17 - 3/24: Spring Break

4/27: Maryland Day

5/3: Art Attack

5/16 - 5/22: Final Exams

5/24:  Main Commencement

7

academ
ic cale

ndar

the dia
mondback

Because these are the dates that 

students really care about.
terp

you
r 

gu
ide

 to

all
 th

ing
s 

um
d 

tailgates
football games
greek life
restaurants college park...and more

dbknews.com/orientation

tips

ORIENTATION GUIDE
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Want to be considered one of the best off campus student housing options at the most crucial times? The Diamondback can put your message directly into 
on-campus residence halls throughout the year with Terp Housing. Pay once to be placed in campus residence halls 3 times during the year. With first and 
second year students living on campus, this audience will soon be looking for campus housing!

Publishes: November 30, 2020 • Ad Deadline: November 13, 2020.

Full Page Listing or Ad 5”w x 8”h $2,000

½ Page Listing or Ad 5”w x 3.9”h $1,250

First Full Page Premium 5”w x 8”h $2,300

Second Full Page Premium 5”w x 8”h $2,300

Back Page Premium 5”w x 8”h $2,300

Inserts
Inserts may not be larger than a 5” x 7” card. Inserts cost $1000 
as a stand-alone product, but that price is reduced to $500 with 
the purchase of any other housing guide ad. The prices listed do 
not include printing. The Diamondback can help with printing if 
needed (pricing will be determined by the job). 

With Ad Purchase 5”w x 7”h max $500

Stand-alone 5”w x 7”h max $1,000

TERP HOUSING GUIDE
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1. Signing a lease without reading it thoroughly.
Carefully read your lease before you sign it; make sure that you understand what all of its provisions 
mean. You can also take your lease to the Undergraduate Legal Aid office and have them review the 
lease with you.

2. Signing a lease without visiting the property & meeting the landlord. 
Signing a lease before viewing a property is a risk - you are legally bound to the property as is, so 
you may be unaware of existing damages that need repair. Additionally, visiting the property allows 
you to not only see exactly where you will be living, but you will also get a feel for the neighborhood 
and whether you would be comfortable living there. 

3. Forgetting consider transportation.
There are many factors to consider when moving and transportation should be a priority. You should 
consider both the logistics of getting to campus and elsewhere as well as the costs associated with 
your options. If you will drive, keep in mind parking permit, gas, insurance, and maintenance expens-
es. If you will be riding public transit, calculate the monthly cost of fares. 

4. Not conducting a walk-through. 
Schedule a walk-through of your unit with your landlord to get a detailed account of pre-existing 
damages to the unit. Take pictures for future reference.  

5. Not considering the cost of utilities. 
Utilities may or may not be included in your rental price. Be sure that you know which utilities you 
will be responsible for activating and paying.

6. Not meeting or speaking with your roommates before move-in. 
Since you will be sharing close living quarters with them, it is important to meet or speak with your 
roommates prior to moving in. 

7. Not setting down house “rules.” 
Everybody has different expectations of new roommate situations. Setting house rules early allows 
everyone to voice their expectations and come to a compromise.

8. Not being clear on the responsibilities of a tenant. 
Just as your landlord has certain obligations to you, you also have certain legal obligations to your 
landlord. Among them are paying rent and, if applicable, utilities in full and on time. Other tenant 
responsibilities include maintaining a reasonably clean rental, taking care of some household mainte-
nance, and notifying the landlord of any needed repairs. 

9. Not securing the rental unit. 
Regardless of where you live, it is always important to be proactive about your safety. Making sure 
your rental is secure is as easy as locking doors and windows, and activating a security system, if you 
have one.

10. Withholding rent or not paying rent on time! 
Some landlords may give a small leeway period for paying your rent, but if you exceed that time 
period you run the risk of late fees or even eviction from the property.

Top 10 Renter Mistakes

Let’s face it — our campus is pretty walkable, but sometimes you need to get somewhere just 
outside of College Park. Or maybe you just don’t feel like walking home to your dorm in the 
bitter January weather. Here’s everything you need to know about getting around on campus 
with the help of DOTS, which is the Department of Transportation Services. 

Buses
UMD has one of the most expansive campus shuttle bus systems in the nation, with 24 bus 
routes that can take you anywhere from apartments in the Varsity and the View to Hyattsville, 
Greenbelt or Silver Spring. 

Most on-campus buses run every five minutes after 5:30 p.m., with off-campus bus schedules 
varying. You can find bus maps and times on the DOTS website, dots.umd.edu. Find out how 
soon the next bus you want is coming with the NextBus website and app.

Besides getting to and from class and your dorm, you can also use the buses to get to some 
more interesting spots, like MOM’s Organic Market, Franklin’s Restaurant and Brewery (in Hy-
attsville), the College Park Aviation Museum or the College Park Metro station for Washington, 
D.C., connections.

Parking
For students with cars, parking can sometimes be a bit tricky. There are hundreds of lots and ga-
rages on campus, each with their own rules and restrictions. Students who wish to register their 
cars for parking can do so on the DOTS website. But beware - freshmen and sophomores can 
register on a space-available basis, while juniors and seniors are the only students guaranteed a 
spot. Annual passes cost $481 for residents and $249 for commuters. Fall semester is $289 and 
$149, while spring is $241 and $125. DOTS offers detailed maps on their website and a parking 
app called Parkmobile. 

Many parking lots will be closing or changing in size with all of the construction going on 
around campus, so be sure to check the DOTS website and Diamondback news coverage peri-
odically for updates.

Metro
Getting into D.C. is as easy as everyone says. Hop on the 104 bus to get to the Metro station, 
or take a quick 15 minute walk from most South Campus dorms and apartments. Once you get 
to the Metro, you’re just a quick ride away from the National Zoo, the Capitol, the National Mall 
and more. Washington is an easily accessible option for internships and social activities alike.

Zipcar
When you need a longer-term rental, ZipCars are another option. Members can rent vehicles by 
the hour or by the day, once you register through the app, you can access ZipCars all around 
the country (not just in College Park, with its many ZipCar stations).

Bikeshare
Just this past April, “grab-and-go” bikes began popping up all around campus. These bikes, 
part of the Zagster bike share program, allow users to sign up for daily, weekly or monthly 
passes. Baas Bikes also have bikes around campus, where you can register through their app 
and pay per hour for bike rentals. Bikes are a great way to get across campus, when you want 
something just a bit quicker than walking.

Transportaion

Elevate your experience in an exceptionally designed apartment 
community. Fuse 47 brings urban style blended with a modern aesthetic 
to College Park, defying expectations and reimagining what apartment 
living can and should be. Welcome to Fuse 47.

Apartments in College Park
that Ignite Your Lifestyle

Arriving Spring 2017

Visit Fuse47.com to sign up to receive
updates about this brand new community.

4700 Berwyn House Rd, College Park, MD 20740
Luxury Student Living
Sparkling Pool w/Cabana
Free Tanning

Direct Shuttle to UMD
24-hour Fitness Center
Fully Furnished

Community-Wide Wi-Fi
Guest Parking
All-Inclusive
Residence Life Program 

LARGEST ROOMS IN COLLEGE PARK

9530 Baltimore Ave
College Park, MD
301.474.0244

Apply online today at www.mazzagrandmarc.com
CAMPUS

NOW LEASING FOR 2017
FREE GARAGE PARKING

College Park Apartment Listings
for the University of Maryland

Even more information about some of the best housing
options for College Park students can be found at 

TerpHousing.com

Campus Gardens
2200 Phelps Road
240.681.1019
southernmanagement.com/
campus-gardens

College Park Housing
Various Locations
collegeparkhousing.org/rent

College Park Towers
4330 Hartwick Rd
College Park, MD 20740
301-864-1070
collegeparktowers.com

Domain College Park
Address: 3711 Campus Dr
College Park, MD 20740
(301) 917-2698
udr.com/washington-dc-apartments/
college-park/domain-college-park

The Enclave
8700 Baltimore Ave 
College Park, MD 20740
(301) 220-3143
cevillages.com/find-housing/
the-enclave-at-8700

Fuse47
4700 Berwyn House Road
College Park, Maryland 20740
fuse47.com

Graduate Hills
3424 Tulane Dr
Hyattsville, MD 20783
(240) 681-1064
southernmanagement.com/
graduate-hills-gardens

Landmark College Park
4500 College Ave
College Park, MD 20740
(301) 798-5990
landmarkcollegepark.com

Mazza GrandMarc Apartments
9530 Baltimore Ave
College Park, MD 20740 
(301) 474-0244
mazzagrandmarc.com

Monument Village at College Park
9122 Baltimore Avenue
College Park, MD 20740
(301) 441-1954
monumentvillagecollegepark.com

Parkside at College Park 
8125 48th Avenue
College Park, MD 20740
301-474-0085
parksideatcollegepark.com

Terrapin Row
4300 Hartwick Rd
College Park, MD 20740
(888) 931-9211
terrapinrow.com

The Towers at UTC
6515 Belcrest Rd
Hyattsville, MD 20782
301-779-2727
thetowersatutc.com

University Club 
4800 Berwyn House Rd
College Park, MD 20740
(301) 345-3388
universityclubatcollegepark.com

University View
8204 Baltimore Ave
College Park, MD 20740
(301) 220-0951
uviewapts.com

The Varsity
8150 Baltimore Ave 
College Park, MD 20740
(301) 446-3790
 varsitycollegepark.com

S T U D E N T  L I V I N G

next level

view
8 2 0 4  B A LT I M O R E  AV E    CO L L E G E  PA R K , M D     3 0 1 - 2 2 0 - 0 9 5 1    U V I E WA PT S . CO M

A PA RT M E N T F E AT U R E S U P G R A D E D  F E AT U R E S !

Basic? Never. You’ll tell stories 
about this place. About those sunny 
afternoons at the swimming pool 
with your squad. Running to the 
24/7 market for study snacks in the 
middle of the night. The yoga 
classes where you met your best 
friendfriend. We offer an unrivaled 
college lifestyle that is set far apart 
from the standard experience, with 
resort-style amenities like stand-up 
tanning beds, two stunning fitness 
centers, and fully-loaded media 
rooms with games, pool tables, and 
TVsTVs. You’ll tell stories – and people 
just might not believe you.

WASHER/DRYER IN EVERY UNIT
FREE STATE-OF-THE-ART HIGH SPEED INTERNET
FREE CABLE
50” 1080P LED TV APARTMENTS
LIMITED ENTRY & ELECTRONIC KEY ACCESS
24-HOUR COURTESY PATROL OFFICERS

CO M M U N I TY A M E N I T I E S

POOL & SUN DECK WITH CAMPUS VIEW
TWO EXPANDED, STATE-OF-THE-ART FITNESS FACILITIES
BARRE & YOGA STUDIO
INSTRUCTOR LED FITNESS CLASSES
RELIABLE & EFFICIENT SHUTTLE SERVICE TO CAMPUS
OPEN DOOR MARKET- 24/7 SNACKS & DRINKS

U  N   I   V   E   R   S   I   T   Y

It’s a source of anxiety for most new college students: what if my roommate and I don’t get 
along? It’s a challenging situation, to be sure, to meet someone for the first time and then live 
in close quarters with that person for a whole school year. Here are a few tips to make your 
roommate relationship as enjoyable aas possible:

1) Clear Communication from the Get-Go: Probably the most important tip for 
any relationship of any kind! As roommates, you’ll be sharing a small space for a long time, and 
you’ll need to respect each other’s needs and preferences. Maybe you like to play music while 
you study, but your roommate can’t concentrate with it on. Maybe you need some quiet time 
each morning before starting your day. Don’t assume that your roommate will just figure all this 
out! This will save you both a lot of conflict.

2) Nip It in the Bud: Solve problems while they’re still small! Is your roommate doing 
something that’s bothering you? Address these issues as soon as you notice them. It will be 
easier to address them in a calm and friendly manner this way. After all, your roommate may not 
even be aware that there’s a problem.

3) Solve Big Problems Immediately: Maybe you tried to follow step #2 and solve the 
problem when it was small, or maybe a huge problem just seemed to explode out of nowhere. 
Whatever the case, don’t procrastinate, don’t wait to see if it’ll just go away. Address the situa-
tion immediately.

4) Your Roommate’s Stuff is Your Roommate’s Stuff: It seems obvious, but this 
is probably the most common problem that arises between roommates. Don’t just assume he 
won’t mind if you finish off his leftovers; he/she probably will. Always ask for permission.

5) Be Cautious About Inviting People Over: You might be an extroverted socialite 
who thrives in a group, but that might not be true of your roommate. Your roommate may need 
some quiet time to study, and bringing a group of friends or classmates into your room may be 
irritating. Talk to your roommate about this to make sure you don’t overstep any boundaries.

6) Lock Up: Imagine your roommate steps out for a moment to grab a snack, and forgets 
to lock the door. You come home to find your laptop and stereo have vanished mysteriously. 
Locking the doors and windows is important for keeping you and your property safe.

7) You Might Not Be BEST Friends, and That’s Okay: Be pleasant and friendly 
with your roommate, but respect each other’s space. Trying to force a best-friend relationship 
will only cause strain and discomfort for both of you. Be friendly, but make sure you each have 
your own life and your own social circles.

8) Keep an Open Mind: Your roommate may have a background VERY different from 
yours. Be open to this new perspective, and respect the differences between you. If you do, 
you’ll find the diversity this experience brings into your life to be very rewarding.

9) The One Constant is Change: College is a time for learning and growth, and both 
you and your roommate will likely change a lot during your time together. Be aware of the 
changes as they come, and don’t cling to the past. Be open to this change and go with the flow!

10) Treat Your Roommate How You Want to Be Treated: Sometimes be unsure 
how to solve a problem between you. When in doubt, follow the Golden Rule, and treat your 
roommate how you would hope to be treated.

10 Tips for a Good Roommate Relationship
Provided by EducationCorner.com
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NEWSSTAND POSTERS
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Place your highly visible, full-color poster on one of our high-traffic newsstands!
Posters are 19”w x 36”h or 26”w x 50”h in size.

$350/Month/Location
Supply your own posters or posters can be printed for an additional charge of $65.

$300/Month/Location
3+ locations in one month OR one placement in 3+ consecutive months. free poster printing included*

$250/Month/Location
3+ locations in one month AND 3+ consecutive months. Free poster printing included*

*Additional copy changes after first month will be charged $65 per poster changed.

Available Locations:
Stamp Student Union
McKeldin Library
Hornbake Library
Bagel Place

•
•
•
•
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Coupons and Flyers Delivered by Hand!
Put your event flyer or coupon directly into the hands of UMD students, 
faculty and staff. Our talented marketing and design team can help you 
build dynamic and effective sales materials that WORK.

DISTRIBUTION COST

FLYER PRINTING COST
Amount Single-Sided Double-Sided

Pieces Cost

100
250
500
750
1000

$45
$65
$110
$135
$145

$85
$110
$120
$165
$190

100
250
500
750
1000

$100
$250
$500
$675
$700

+ Brand Ambassador Services
Wearing Branded Clothing/Gear
Just $50 with the supply of sufficient quantity of company brand hats, 
shirts, etc. for the promo squad members.

Bulletin Board Posters
The Diamondback can get your message front and center in all the busiest parts of campus. 
Your poster or flyer will be posted where students spend the majority of their time. 
$200 for 100 flyers
Design and printing services available

Sidewalk Chalking
Chalking: name/event, short phrase, URL (max 7 words + URL) 
Cost: $35 per chalking, up to 3-4 colors
Size: standard 4x4 sidewalk square
Additional words/space at additional cost 

PROMO SQUAD

3136 SOUTH CAMPUS DINING HALL, COLLEGE PARK MD 20742 • 301-314-8000 • WWW.DBKNEWS.COMTHE DIAMONDBACK

Prime Campus Locations
(minimum 3 chalkings per location)  
McKeldin Library
McKeldin Library mall pathways
Stamp Student Union
South Campus Dining Hall
Hornbake Library
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Gen Z and millenial users are true digital and mobile natives consuming 70% of their news content on their mobile devices. Diamondback digital advertising 
is sold on a cost-per-thousand impression basis and will appear on all of our digital platforms and in a variety of ad sizes until the the advertisers budget and 
or impression goals are fulfilled.

Banner Advertising (cost per thousand impressions)
$10 - The University of Maryland, Nonprofits and Student Groups
$11 - Standard Rate
$12 - National Advertisers
$15 - Specified Banner Positions

Making your own ad? See the Creating An Ad section.

Article Text

Article Text

Article Text   300x250 Mobile Banner

  300x50 Mobile Banner

  300x50 Mobile Banner

300x250 Banner

Article Text

300x600 Banner

300x250 Banner

728x90 Banner

THE DIAMONDBACK
THE UNIVERSITY OF MARYLAND’S INDEPENDENT STUDENT NEWSPAPER

Text Links
These appear in 
the sidebar of each 
desktop and mobile 
page.
$50 per Month

ONLINE ADS
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CROSSPLATFORM ADS
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Billboard “Takeover” Ads
A premium position on DBKnews.com. Relevant advertising is highly valued by our readers and messages appearing in these positions consistently achieve:

Billboard ads often gain much higher engagement than 
standard ads, appearing at the top of the page so users 
will view them before moving on to any other content.

Advertisers have flexibility on timing and structure of 
these ads. Compelling images, interactive quizzes, and 
other creative engagement mechanisms are all possible.

People who interact with takeover ads convert to buyers 
or users at higher rates relative to other online ad formats.

High Engagement Flexible DeliveryHigh Conversion Rates

Billboard Combination
Appears on both desktop & mobile

100% of impressions / week: $1000
100% of impressions / day: $200
50% of impressions / week: $750
50% of impressions / day: $150

Article Text

THE DIAMONDBACK
THE UNIVERSITY OF MARYLAND’S INDEPENDENT STUDENT NEWSPAPER

1000*x300 • Desktop Billboard
*background will be added to add an additional 920px
100% of impressions / week: $600
100% of impressions / day: $100
50% of impressions / week: $350
50% of impressions / day: $75

400x200 • Mobile Billboard
100% of impressions / week: $600
100% of impressions / day: $100
50% of impressions / week: $350
50% of impressions / day: $75

250x120 • Sidekick
$500/week or $150 per day
Includes all mobile & desktop platforms
Appears once every 5 minutes for each visitor

Article Text

THE DIAMONDBACK
THE UNIVERSITY OF MARYLAND’S INDEPENDENT STUDENT NEWSPAPER
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THE DIAMONDBACK
THE UNIVERSITY OF MARYLAND’S INDEPENDENT 
STUDENT NEWSPAPER

On each purchased day of sponsored content the article: 
Appears on the homepage within other breaking news stories
Gets posted onto The Diamondback’s Facebook wall 
Gets included in that day’s Diamondback e-mail newsletter
Includes Twitter blast to the 23,000+ followers of @thedbk

1st Week Add 2nd Week

$900 + $300
includes writing & design

Frequency Discount

SPONSORED CONTENT
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People following facebook.com/TheDiamondback on Facebook.

People following @thedbk on Twitter.

24,100+
10,700+

Email Edition
Sent out to all of The Diamonback’s 9,800+ email subscribers!
Your ad will be featured on an email sent every day Monday–Friday.

728x200 pixels
$150 per week 

Direct E-mail
Direct E-mail Advertising to Current Students and Recent Graduates.
Perfect for education advertisers and employers!

1000 Minimum
$.50 per email address for random delivery to students & majors
$1.00 per email address for targeted delivery to specific majors

720x200

720x200

SOCIAL NETWORKS & EMAIL
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Sponsored Tweets
Tweet your message to over 23,800 followers on twitter.com/thedbk.

Limit of 280 characters per tweet. Tweets must begin with “Sponsored:” 
You may include links and/or hashtags.
You may include an image. Photo must be approved by deadline.
$40 per tweet.

https://www.facebook.com/TheDiamondback
https://twitter.com/thedbk
https://twitter.com/thedbk
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CHECKING THE SIZE
Checking PDF Size in Acrobat
Drop your ad into Adobe Acrobat.
At the bottom, you should see a measurement.
If not, you may need to turn on Rulers:
View > Show/Hide > Rulers & Grids > Rulers

Checking Size and Resolution in Photoshop
Drop your ad into Adobe Photoshop.
Go to: Image > Image Size

PRINT
DO NOT INCLUDE CROP MARKS OR BLEEDS IN YOUR ADS. 
The ads we receive should fit exactly to the desired ad space.

Color: CMYK
Use 100K for black areas/text, not a mix of CMYK colors to avoid blurring.
Images pulled directly from the internet will probably be in RGB, so be sure to check. 

No Spot / Pantone Colors
Resolution: 300 pixels/inch
Save As: PDF (fonts embedded) or TIF (flattened, LZW compression)

These are guidelines for creating your own ads.

ONLINE
ADS OVER 50KB IN SIZE MAY BE RESAMPLED.

Color: RGB
Animated GIFs may require lowered color numbers to stay under the 50kb file size limit. 
Transparency in GIFs and PNGs is not supported.

Resolution: 72 pixels/inch

Save As: PNG, JPEG, or GIF
If you are using Photoshop, simply use File>Save for Web. You ad’s file size must be under 
50kb. PNGs are larger. JPEGs are great for blended colors and gradients. GIFs are best for 
solid colors and will also allow some animation.

CREATING YOUR AD
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